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WebSphere Studio Application Developer, WSAD, is the follow-on technology to VisualAge for Java and WebSphere
Studio. It consists of a common workbench and integrated set of tools that support end-to-end development, test-
ing, and deployment of e-business applications. This presentation will describe some of the tool's functions includ-
ing the Java, Data and Web perspectives to DB2 data on Windows, Linux and z/0S platforms. Demonstrations will
be shown in the Expo area.
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~ WebSphere Studio Application Developer, WSAD, is the follow-on technology to
VisualAge for Java and WebSphere Studio. It consists of a common workbench
and integrated set of tools that support end-to-end development, testing, and
deployment of e-business applications. This presentation will describe some of

the tool's functions including the Java, Data, Web and Debug perspectives to
DB2 data on Windows, Linux and z/OS platforms.
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» The Redbook, SG24-6407, by Ueli Wahli, has been used extensively in creating
this presentation. The Redbook, includes both presentations, and
corresponding exercises using WSAD V4.02 and DB2 UDB for Windows on V7.

» Corresponding equivalent schema have been created on DB2 for z/OS on V7 and
on DB2 on Linux for z/OS V7, which are used in this presentation. The schema
DDL for z/OS can be found at in the Appendix at the end of this presentation.
The schema used to generate the Windows DDL is found in the appendix of the
Redbook and also used to create the Linux DDL.

~ Additional material, including the DDL and Data used in the exercises, code
snippets for the exercises, solutions and minor corrections can be found at:

~ ftp://www.redbooks.ibm.com/redbooks/SG246407
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Topics

= WSAD - What is it?
= WSAD Perspectives
» Java
» Data
»Web
» Server
= Testing
= Debugging
= Miscellaneous
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» The topics that will be covered are listed on this slide.

» Focus will include accessing DB2 data on Windows, z/OS and on Linux on z/OS,
and how to switch the application to access one platform, and easily change to a
different platform which could be used during development stages.

September, 2002 (c) IBM Corporation



» WebSphere Studio comes in multiple configurations to best meet your Web

WSAD - What is it?

= WebSphere Studio Application Developer (WSAD)

» Comprehensive Development Environment

» Follow-on technology for WebSphere Studio and VisualAge for Java
= Based on Eclipse Workbench (www.eclipse.org)
= Part of WebSphere Studio Application Family

1. WebSphere Studio Site Developer (WSSD)

2. WebSphere Studio Application Developer (WSAD)

3. WebSphere Studio Application Developer Integration Edition
(WSADIE)

4.WebSphere Studio Enterprise Developer (WSED)

= One tool designed with multiple perspectives, views and editors
to work with resources

[LIE] oata Management Soltware Tmms

development needs. The configuration being covered today is WSAD.

comprehensive development environment based on the Eclipse workbench. Itis
part of the WebSphere Studio Application family, where each configuration

includes the predecessor one. WSAD, includes the functions of WSSD plus the
following::

» In addition to including features in the Site Developer, WSAD provides:
» Full EJB 1.1 support
» J2EE 1.2 support
» Profiling (performance analysis tools)
~ EJB deployment
» Migration and interoperation with VisualAge for Java
» Full database support for many platforms and database vendors

» The product is one tool that provides many different perspectives, or views for the

function being performed by the developer.

September, 2002
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WSAD - What is it? ...

= \WebSphere Studio Tooling Platform

WebSphere Studio Enterprise Developer

Application Developer Integration Edition

P
Application Developer

* Services
architecture for

® Visual Assembly

( site Developer accesSINFESS Tool
resources * Apache
: ¢ J2C Connectors Struts Builder
¢ HTML/JSP T_oollng * EJB Tooling (CICS, IMS, HOD) « E/C/D for
i Tooling © Performance 4 o MicroflowlBuilder =+ cosoLpL1
¢ Web Services Tooling and Trace Tooling « CCF Connectors e EGL
¢ XML Tooling * Advanced Data  Runtime Only Development
¢ ClearCase LT OEM Tooling « VAJ EAB migration T
Document

e
WebSphere Studio Workbench

¢ IBM's commercially supported version * Basis for IBM Tooling in the future
of Eclipse Workbench

J\<

Eclipse Workbench

* Universal Tool Platform Initially Developed by IBM
* Basis of Open Source Project (www.eclipse.org)

* Provides frameworks for tool builders to
focus on tool building
¢ e.g. Core JavalIDE
¢ e.g. core VCM API/CVS Plug-in
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» This chart shows how the different products build on each other starting with
WSSD and ending with WSED.

» The URL, http://www7b.boulder.ibm.com/wsdd/zones/newcomers/ includes
detailed information on all of the different products described on this slide.
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WSAD - What is it? ...

= End-to-end support for application development:
» Java/J2EE
» Relational Data
» Web Applications
» XML
» Web Services
» Debugging & Profiling
» Team support
» Server configuration
» Unit testing
» Plug-in development
= Highly customizable
= Extensible

1] oata Management Sattware T

» WSAD is an open-standard J2EE application development product that
represents the next step in an evolutionary path that began with VisualAge for
Java Enterprise Edition and WebSphere Studio Advanced Edition. It is a member
of the new WebSphere Studio family of application development products that
also includes WebSphere Studio Homepage Builder, WebSphere Studio Site
Developer, and WebSphere Studio Enterprise Developer.

» The items listed on this slide are included. The environment, including panels, is
highly customizable and can have plug-ins added (vendor or user written).
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WSAD Perspectives

. & Select Perspective X
What are they? 2 R
. . BEDala -
m Perspectives provide role based 55 Deug
views of panels based on tasks &) Help
» Perspectives can be customized Eh@jﬂ ety
by developer F.E M
. . Java Type Higrarchy
» Multiple perspectives can be B Pugn Development
opened qt atime % Profiing
m Provides different look and feel ) Resource
for different functions % Soipts |
» Menus, toolbars, icons ??E’“’Ef
= Editors - source and design p-‘ﬂfahm |
= Many wizards included
1] 4 | Cancel |
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» The WSAD tooling operates using perspectives, which are:

» "canned", where you select from a list of predefined views, or they can be
"customized”, where you create your own set of views

» Multiple perspectives can be opened at a time, and are easy to switch between.
Each perspective affects the toolbar and menu bar.

» A different look and feel is presented with each perspective with the supported
options related to the task being performed. Different views have different
purposes which allow you to browse or edit a set of information in a particular
way. E.g. from the Java Perspective, there is a Tasks view, Java
Hierarchy/Packages views, and an editor view

» The Navigator view shows all the files and resources in your workspace in a
project/folder hierarchy, and many of the persectives include a ‘Navigator' view.

~ Different editors are provided for source and design of the different resources.

» Many wizards are included to help create new resources and generate code.

» The graph on the right shows how you select a perspective to operate in.

September, 2002 (c) IBM Corporation



Perspectives Covered

= Java
m Data
= Web
m Server
= Debug

= Comparable DDL and SQL files created on

» DB2 on Windows V7
— Updated data in SQL file to include "Windows"

» DB2 on Linux on z/OS V7 (no changes needed to DDL)
= Updated data in SQL file to include "Linux390"

» DB2 on z/OS V7 (minor changes needed to DDL)
— Updated data in SQL file to include "DB2V7390"
= See Appendix at end of presentation

[LIE] oata Management Soltware R mms

» The perspectives covered in this presentation are listed on this slide. The
examples used in these perspectives will access DB2 data on multiple platforms,
including Windows, Linux and z/OS. The same DDL was used on the Windows
and Linux platforms. Minor changes, included in the Appendix at the end of this
presentation, were made to create the DDL on z/OS. Significance was placed in
the data of each platform tables, as described on the slide to show which
platform is being accessed in the examples.

» The initial DDL and Data used can be found in the additional materials for the
Redbook at:

» ftp://www.redbooks.ibm.com/redbooks/SG246407

September, 2002 (c) IBM Corporation



Java Perspective

m Functions included

, Cioes navigaton e

» Editor content assist & syntax

highlighting Select

» Incremental build - manual or automatic Cesle a Java package

» Tight integration with Tasks view

= Tools 08

» Wizards - packages, classes, i
interfaces, methods, source folder R

» Browsing support . FE

» Debugger & profiler

» Project properties - define source - Plgyin Developmert

folders, build path and output

m Packages, Hierarchy & Java Beans
views and Java editor
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i Java Prject

# Java Package

(O Java Class

i Javanlerace
Mava Seanhonk Page

» Functions supported in this perspective are listed on the slide. Syntax errors are
highlighted in the Tasks view to assist for easy identification and correction.

» The tools include many wizards to help develop your code. Editors exist that
allow you to easily modify any generated code. Debugging support is described

in more detail later in the presentation.

» When viewing the properties of the project, you can define source folders and
identify any needed files (jars/zips) to build the application.
» The Java perspective includes views for Packages, Hierarchies, creating Java

Beans as well as a Java editor.

» The picture on the right shows the choices of what can be created from the Java

Perspective.
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Java Perspective ...

= Redbook Exercise 1

» Java application using DriverManager
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» Functions supported in the Java perspective can be seen when following the
steps in Exercise 1 of the Redbook which creates a Java application, Listing, that
displays a parts listing.

» The application is easily tested by clicking on the 'Runner' icon on the toolbar.

» This examples uses DriverManager to connect to the database, which includes
hardcoded connection information in the application. Since we created
comparable DDL on Linux and z/OS DB2 systems, switching to different DB2
servers, only requires changing the connection information.

» The DB2 Client Configuration Assistant (CCA) is used to define access to the
different DB2 servers by an alias name. To change access to the different
platforms, only requires changing the connection alias and userid/password, then
recompiling and running the Java application.

» Tests were run against each DB2 platform - changing the following line of code
» DB2 V7 on Windows (alias ITSOWSAD)
» con =
DriverManager.getConnection("jdbc:db2:ITSOWSAD","peggyr","mypwd");
» DB2 V7 on Linux on z/OS (alias DTSOWSAD)
» con = DriverManager.getConnection("jdbc:db2:DTSOWSAD","peggyr","m
ypwd");
» DB2 V7 on z/OS (alias DB7P)

September, 2002 (c) IBM Corporation 11



Data Perspective

= Functions and Tools included
» Database connection

» Work online or off-line X
» Browse or edit database 0 [ Daas
schema @Schema
» Create Databases -ER B Tatle
» Create Tables i £ S0L0DL Sorpt
> Generate DDL i 20301 Sttement
» SQL Builder to create SQL §
statements | - Fluc-n Develogment

= DB Explorer, Data, Navigator &
Tasks views and editors
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» The Data Perspective provides views and tools for definition and maintenance of
descriptors for database, schema, and table definitions.

» This perspective supports a Server view or Local view of database schema, which
allows database information to be imported to a 'local' mode to allow development
without being connected to the server.

» Wizards exist to help create databases, tables and SQL statements

» The operating views related to this perspective are described at the bottom of this
slide.

» The picture on the right shows the choices of what can be created from the Data
Perspective.

September, 2002 (c) IBM Corporation 12



Data Perspective ...

= Connecting to a server uses the - Connection Wizard
» Defined in Data Perspective, DB Explorer View

Database Cannaction
Extnblizh s JOSC connecion o adatshase :&:
. Conneciion nams o s RSO3
DB7PIs \ = st e
Detaboe foerF
User O jpagegy
DB2 V7 Prassward |
Detabes vendce veo. |(EEENE TR - |
on z/0OS JDEE divar [18r DBz 2FF DRMER =]
Hiest: |
[Optanal] Fart nursar |
Bardar nanrs |
JOBC drivesr cimss: | SR iz app OEED
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Cannacian UAL: I dbcam:LIE
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» To connect to a DB2 server uses the connection wizard which is accessed from
the Data Perspective, in the DB Explorer view.

» The example on this slide shows connecting to a DB2 on z/OS V7, using the
previously defined, CCA alias, DB7P. The Database Vendor type of DB2 UDB for
0S/390 V7 is selected.

September, 2002 (c) IBM Corporation
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Data Perspective ...
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» Using the Data view, you see the previously defined table, ITSO.AAINVENTORY,
expanded for DB2 on Windows and for DB2 on z/OS. Selecting 'PARTNUMBER'
from our z/OS version of the table opens up the table in the right hand window
where we can view information related to '‘General, Columns, Primary Key and
Foreign Keys' Schema changes can be made, and DDL can be generated.
Since you are operating in Local mode at this point, switching between systems
and viewing table definitions is very quick.
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Data Perspective ...

m Create New SQL Statements
= Select, Select Distinct, Insert, Update, Delete

= Create from

» Wizard - SQL Assistant

» Resource and invoke SQL Query Builder

» Manually
= Use existing database model
= Connect to database and import new database model

1] oata Management Sattware & = ms

» From the Data Perspective, you can create new SQL statements, query, update
and delete. The panel, shown on the next slide, provides selection of the DB2
table, and input for a name, and manner in which you wish to create your
statement, using:

» A wizard, that drives the SQL Assistant code

» A resource, that invokes the SQL Query Builder, which provides drag and drop
to build the statement

» Manually, where you write your SQL statement.

~ When creating a new SQL statement from this option uses a database model that
has previously been created or imported to WSAD, or you can connect to a
remote server and import the model you wish to use.

September, 2002 (c) IBM Corporation 15



Data Perspective ...
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» This slide shows the "Create a New SQL Statement" panel.

» First, we'll create SQL Statement for 'SELECT' and use the SQL Assistant wizard
against our DB2 on z/OS V7 database.

September, 2002 (c) IBM Corporation
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Data Perspective ...

= Be guided through creating an SQL statement

3reate a New SQL Statement

Construct an SOL Statement

Specify information on each tab to create the SOL statement. Press MNextto see the generated state:

Tahkles I 5 | Columnsl < .quinsl &= Ccmditicmsl s 8 Groupsl a5 Orderl

Choose the tables that wou wantto use inyour SCOL staterment. vWou must provide an alias if wou sel
more than once

Auwailable Tables Selected tables

=-8E ITSO = Table

E!ZI Tahles ITSO Al MWERTORY

o E TS0 AAINVERNTORY ITSO.AAPARTS
- ER I TEMNUMBER  INTEGER

&8 PARTHUMBER | CHAR
e B QUANTITY  INTEGER
-~ B COST : DECIMAL
- B SHELF : CHAR
— B LOCATION : WARCHAR
o-EH ITEOAAPARTES
- E#E PARTHUMBER : CHAR
B MNARME  CHAR
- B DESCRIPTION : waARCHAR
- B WEIGHT : DOUBLE
o B IMAGE_URL : WARCHAR

m-EH I TSOMMINVENTORY =

< Back I et > I

» This slide shows the panels in the SQL Assistant. From this wizard, you can
» Select one or more tables

» Select the columns of each table to be included
» Identify how the Join is constructed between the tables
» Specify any Conditions for invoking this statement
» ldentify any Grouping or Order for the output of the statement
» When you have completed creating the SQL statement, you can execute it to see

if the results are what you expect before continuing further, and modify the SQL
statement in the wizard if your results are incorrect.
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Data Perspective ...

= Create an SQL Statement from invoking the SQL Builder
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» This next example shows creating the "PartListing" SQL statement using the SQL
Builder. This example uses Exercise 2 in the Redbook.

» Two tables have been selected, MMINVENTORY and MMPARTS

» The query builder is used to 'check’ the columns, establish the join, and specify
the order for this statement. Upon completion, the SQL statement can be
executed.

» The SQL Query Builder uses drag and drop and point and click to create the
statement.
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Data Perspective ...

= SQL Query Builder - Test Query @
» Click on "execute the SQL statement” icon —# |3k
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» This slide shows how the execution of the statement is made. When positioned
on a SQL Statement from the Data Perspective, select the "execute the SQL
Statement" icon from the toolbar.

» This displays the "Execute SQL Statement" panel, where you see your statement,
and can click on "Execute".

» If host variables are used, a panel will appear where those can be entered.
Hitting the "Enter" key causes the SQL statement to execute and the results
returned.
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Data Perspective ...

m Generate DDL

» Generate with full qualified names
» Generate with delimiters

SGenerate

Generate SQL DDL l.lzl_g:
Generate S0OL DDL for the selected
ohject

Folder IfltsDWsDealerDatabase

File name: IDEI?F’.sqI
Options

W Generate SQL DOL with fully qualified names
I” Generate S0L DOL with delimited identifiers

™ Open SOL DOL file for editing when done

Einish I

Cancel

1] oata Management Sattware

» Also from the Data Perspective, you can generate DDL for any database or table

and other resources. You can select to have the generated DDL include fully
gualified names, as well as include delimiters.
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Data Perspective ...
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COST DECTMALELO, 23 nOT MLLL,
SHELF CHERIZ], :
|LOCATION 'n'AFI'_H#F‘[EI'_II:I_:_,
al
TN 0ats Management Sottware Imma

» This slide shows the example of the DDL for creating our DB2 on z/OS V7 tables

used in this presentation. The generated DDL creates a 'sql' extension file, and
can be edited.

» This can be useful when migrating databases and tables between DB2
subsystems.
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Web Perspective

= \Web Developer Perspective

Server

Browser
Servlet

HTML

page
(form)

HTML

page
(result) compiled
JSP

access bean

I8 st Manapement Sotiware L

~ We'll now look at the Web Perspective. First, a quick review of what's included
when creating a Web application.

» An HTML page is displayed in a browser. The HTML page contains a form
where the user can enter data and submit the form for processing.

» The Web server passes the request to an application server that schedules a
servlet to process the form.

» In the model-view-controller (MVC) design pattern, the servlet is the controller.
The servlet uses a JavaBean (the model) for the business logic. The JavaBean
performs the requested tasks, for example, by accessing a relational database.

» The servlet then invokes a JSP (the view) to format the HTML result page. The
JSP accesses the JavaBean to retrieve the result data of the processing task.
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Web Perspective ...

= Many features from

WebSphere Studio 4.0 Select
» HTML and JSP editing BAlBEE R
= Includes Page Designer —
» WAR import/export Dere 3?32”““
- ; EE i HThAL File
» Links view e W ISP Fis
— Shows relations between linked Javn i C35Fe
files Phigrin Dewelcpmen # Imace Fie
) Plermeie Fie Transler & Jovm baon 'Wab Frgas
» Wizards to generate servlets Sener (B Dnshsee ol Pages
and JSPs for database and %E‘
JavaBean applications “Web Sendces
HML
» Debugger for JSPs at source i

code level

1] oata Management Sattware § =

» Many features from WebSphere Studio 4.0 are included in the Web Perspective
as described on this slide.

» WAR (Web ARchive) files can be imported and exported.

» Wizards are included to generate servlets and JSPs. The debugger can be used
to process a JSP at the source code level (described later in this presentation).

» The picture on the right shows the choices of what can be created from the Web
Perspective.
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= Example 4 in the Redbook

= % web - application Developer

File  Edit Ferspectve Project  Window  Help

S E e 8 SRS [ SH | B| F L Rm s e]n
== @ ~ x || 41 ParListjova i PartListhtml >0 || PariListjsp
B |le 5 PartListhtrnl - Partlisthtml | Booy = |
T || B tsovwsDealaerParts -
= tsovwsDealerweh @
E iy e «* Redbooks
E::jl El'B’WEbApphCEﬂIDH PAGE
a0 EeE images = =
il & e wesiue Parts Lasting DESIGNER
FH FILES |'_1| Fartlist html | -
T L] Parlistjsp Enter a partial name: | IS
§ ~[E classpath bl /e
e
4 | | »l
f@uﬂine) e Design | =ource Prewview |
g DOCTYPEHTML = & Links LN
& frE] HTRAL —
=-<I> HEAD
LlNKS q — = ] redbooks.gif
T _ - Parlist
Fartlist.htm
=t - FORR
H o AP ] 1T LI =l T
Gallerleutlinel Tasks|Perer‘tieslLinks|Thumbnail{ﬁry|— Tabs for other views

» This slide is an example of the output from Exercise 4 in the Redbook which
creates an HTML, JSP and Servlet using the wizards.

» The Web Perspective contains four panes:

» Top | e f t —Navigator view (displays the folders and files of the projects)

» Top right reserved for editors

» Bottom left Outline view (of current editor) or Gallery (for HTML/JSP files)

» Bottom right Tasks (errors), Properties (of selected resource), Links (of Web
resources), Thumbnail, Styles, Color, Palette (Web resources)

» One of the supported editors is the Page Designer for HTML and JSP files. The
Page Designer itself has three tabs to display the Design (WYSIWYG), Source
(HTML source code) or Preview (browser) view.

» Selecting the 'PartList.html' in the Navigator view causes the other panels to be

populated. Clicking on the different views in each panel, shows different
information.
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= Using Database wizard
» Click "Create Web Create Database Web Pages
PageS that access and Create Web Pages to Access a Database
dISp|ay database fleldS" Create wehb pages that access and display database fields.
icon
» Check
= Create Input Form
= Create Details Form
» Select Model of View
Bean wweh Pages
= Generates JSP M Create Input Farm
. M () ils Fi
» Store results in request reete petals romm

Destination folder: IIItsoWsDealeMebMebApplic:aticm

Javwa package: I

I Use Style Sheet: I

I~ Use Error Page: |

kdodel:

Store resulis in
= Raquest

" Session
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» The next few slides, take you through creating a Web Project, e.g., HTML, JSPs,
and Servlet code following the steps in Exercise 4 in the Redbook.

» From the "Web Perspective" we select the "Create Database Web Pages that
access and display database fields" icon from the toolbar.
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» The Create Database Web Pages starts by constructing a SQL Statement using

Web Perspective .

= Next, construct an SQL
statement using wizard
» Point and Click
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M0 MMRYENTORY

MO MWPARTE

the same SQL Assistant wizards described previously.
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= Execute SQL statement during creation

‘e weth fe S04 sinieean!
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» As was shown previously, the SQL Statement can be executed during creation of
the statement from the SQL Assistant panels. Additionally, selecting the SQL
Statement can be executed after creation from the Outline view.
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= \When SQL Statement is complete, click Next
» Design Input Form (HTML)

= Change
Properties
> Label
» |nitial
Value
» Size
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Create Cafalase Wels Pages
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» When the SQL Statement creation is complete, click 'Next' which takes you to a
panel to design an Input HTML form, if a 'Host Variable' was included on the SQL

Statement creation.

» From this panel, you can change the properties of any of the input variables, e.g.,

the label or size.
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= \When Input Form complete, click Next
» Specify Runtime Database Connection

Create Database Web Pages

Specify Runtime Database Connection Information

Enter information for establishing a databaze connection at runtime.

= Choose % llse data source connection
COI‘lneCtion type Data sourcedIMDI name: !|dbc£ITSDWS.&D
» DataSource " Use driver manager connection
. Diriver name: |EDM.ibrn.db2.idbc.app.DB2Driver
» DriverManager
URL: Jidbe:dbZ DETR
Uszer |D: I

Pazsword: !

Re-enter pagzword; I

1] oata Management Sattware T

» Clicking 'Next' takes you to the panel where you specify your database
connection information used at Run time. You can select DataSource or
DriverManager.

» While our Java Application created earlier in the presentation used
DriverManager, and required changing the Java Code to select a different DB2
Server, our servlet will be created using DataSource.

» We enter a DataSource/JNDI name of: Jdbc/ITSOWSAD
» The JNDI information for connecting to the specific DB2 server will be
configured later
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= Create Main Result Table (JSP)
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Colurn 'Wickh. . Fuels

Colurn Wickh &
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» Two JSPs are created by this servlet. The first JSP, is a Main result table, where
one to many entries could be returned. You can select all or just specific
columns to include in the JSP. Additionally, you can change properties, such as
the label that gets displayed.
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= Create Details Result Table (JSP)
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» This is the 'Details’, the second JSP for this servlet. Again, you can select all or
specific columns to display, and change the properties listed at the bottom.
» Only one database record is returned on the details JSP.
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m Create Servlet

@ » Select "Create a Java Servlet Class" icon
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» The Input HTML and output JSP Web Pages have been created. Now, we'll
create the servlet code using the "Create a Java Servlet Class" icon.

» The first thing you do is name the servlet and select the init(), doPost() and
doGet() methods.

» Clicking 'Next' returns the "Define the Servlet in the Deployment Descriptor
(web.xml) file, which we want for our servlet.
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m Create Servlet ...

» Output creates
= 3 servlet files in source package folder

= One HTML
= Two JSPs
Java Source HTML & JSPs
Eu{g{“;:ﬁj?;aleweb E{B webApplication
56 itso - B images
5 wsad - w i WEBINF
= dedler ] InventaryDetailsViewjsp
B+ dbapp . o] InventorylnputForm bl
: & i InventnryContrlnllelr.]ava . q InventoryMasterView jsp
[ InventoryDetailsYiewBeanjava CE

i 1) InventoryMasterviewBeanjava
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» Clicking 'Finish" completes the servlet creation which creates 3 servlet '.java' files
in the source package folder in addition to compiling those into ".class' files in the
WEB-INF folder.

» The bottom left side of this slide shows the Source folder of the 3 servlet files
while the right side of the slide shows the name of the JSPs and HTML files.
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Server Perspective

m Create Server Instance

Create a Mew Server Instance and Configuration

Create a new server instance and configuration E
Choose the properties for the new server
Select WebSphere Test
Server name: |ItsoWsDeaIer Environment
Folder: LI
Senver instance type: =B \WebSphere Servers
i @R wWebSphere w4 0 Remote Server
i enonhere w0 | Bat CrnAronmment
+ #% Apache Tomcat
¥ TCPIP Monitaring Senser
Template: INDne Create @ Wew Server Instance and Configuratio
Description: Funs all J2EE projects directly out of t WebSphers Sarver Configuration Setllings

Input sativgs bar the raw Nyab Sahere servar carfigure

HTTF poet numibsar (5060
Sersar configuration type: S WehSphers «4.0 Configuration P E

Template: INDne

Default port 8080
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» To test a servlet requires a Server Instance to be started. This slide shows
creating a new Server Instance that will appear in the Server Perspective

» Start by naming the server, then select the type of Server instance that will be
used. We select the WebSphere Test Environment which listens on the default
port 8080.
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Test Servlet

= From Server Perspective

» Configure DataSource
- select server-cfg.xml

* select Data source and click Add
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» Now we are ready to test our servlet. Before we do, though we need to configure
our DataSource in this server. This is done in from the Navigator view. Select the
server-cfg.xml file for the server instance we defined.

» Click on the Data Source panel in the right window.

~ Positioned on the Db2JdbcDriver in the top part of the right panel, click 'Add’ for
the Data source defined in the JDBC driver selected above.
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B Edit a Data Soures
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» This panel is where you enter your DataSource information.

» Enter ITSOWSAD for the name and jdbc/ITSOWSAD for the JNDI name. Enter
any description you wish.

» For the database name, enter the CCA Alias for the DB2 Server you want to
connect to, along with the userid and password for this DB2 Server, since our
example didn't include externalizing panels to enter and pass this information.

» This is the only panel that needs to be changed to run our servlet and obtain data
from different DB2 servers, provided all DB2 servers have same SCHEMA names.
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= From Server Perspective
» Start Server in regular (non-debug) mode
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» From the Server Perspective, we select the ItsoWsDealer Server Instance we
created and 'Start' the server. At this point we are not starting in 'debug’ mode.

» The server is started and ready to execute our servlet when you see the 'Server..
open for e-business' message on the console.
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» From the Navigator view in any of the perspectives that support Navigator, we
select the InventorylnputForm.html that we created, right click to get the

Test Servlet ...

= From Server or Web
Perspective

» Select HTML
= Run on Server
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pop-down menu, and select '‘Run on Server'.
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Test Servlet ...

=» WebSphere Test Environment started - Port "8080"
= Enter "12" for the QUANTITY

» Click Submit
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» Our server is started using the WebSphere Test Environment that we defined,
since we are listening on Port "8080".

~ Entering a quantity of 12 and clicking Submit, will search for any parts that have
an inventory 'less than' 12, since our SQL Statement was created with an
operator of '<' (less than) the number entered.

September, 2002 (c) IBM Corporation



m Select a PARTNUMBER
» Click
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» The Main JSP results are returned, which is a 'result set'.

» Selecting Partnumber 'T1' and clicking 'Details' returns detailed information
about this part on the next slide.
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= Part number Details returned
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» The Details of Partnumber T1 are returned.
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Debug Perspective

= Enables debugging of Java code
= Views display source code
» Breakpoints can be set
= Running processes are shown
= Variables displayed
» Values at current breakpoint
= Evaluated expressions
= Inspector for in-depth data analysis

1] oata Management Sattware T

» The last perspective discussed in this presentation is the Debug Perspective.

» You can debug Java programs or JSPs. You set breakpoints in the source code
of both. When the debugger is invoked, you see the processes that are running.
Variables are displayed and values are shown for the current breakpoint.

» Any expressions are evaluated and the resulting values are shown.

» Select the 'Inspector' option provides in-depth data analysis.
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Debug Perspective ...

= Debugging Java application
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» This slide shows an example of debugging our Java application used in the Java

Perspective earlier in the presentation.

» In the Listing.java source, we have set a 'breakpoint’ on the System.out.printin.

When we run the Java Application, the debugger is started.

~ At the top left portion of the slide displays the processes that are occurring. The
top right portion, you see the breakpoint and the options you can perform at this

point.

» The middle left portion displays the Java source, with the outline view being

displayed on the middle right.
» The console output is displayed at the bottom of the slide.
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Debugging

m Set breakpoints in JSP or Java source
» Locate line in code

. e . ST
= Right click, Add Breakpoint *60masterViewDBBaan . sat
62 3
BE3<x——-Execute the gueil]
T
2[ Add Bookmark... A=
61 Add Task...
B
At
80 oo =
IrreEnl Oy aste i b a0 - Pt Tabis
R L e T “IrwEE T T
B2 SEESlOn  SATATTIIBULS [ “UUAKTITY ", reguast . JetParamatar | b 13
i 1
B4t
B5
=
TYE
- JrT heemt 51 mIa L
=
s#slnos twrY iewDBBean - setQUOANTITY ( [(Strang iswssion . getAttribute | I [
Bl
B2
35l Breakpoints added
#EfmasterYiewDibean .execute | )
=6
ST
Ho ] Avm Soript
S "ETET T BRITHTAMAR o' Tasrs Heayd i

4l

TR - 1,“.,.:,“ v et

1] oata Management Sattware i ma

» To set a breakpoint in either JSP or Java source, you first locate the line you want

to stop on in your code.

~ When you right click, you get the popdown where you can request, 'Add
Breakpoint'.

~ In this example, two breakpoints have been added to the JSP.
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Debugging ...

= Servlet Debugging
» Start Server in 'Debug’ mode

Wl Servers

% Sarver Configuration X

=04 Server Instances
1 4 IsoWsDealer
! 2 hsowsDealer # Stat
=68 Server Confiqurations 4 )
{ﬁ? ItsoWsDealer "_ Restt
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» The debugger is launched automatically when breakpoints have been set, and
running against a Java application in the Java Perspective.

» To enable debugging for Servlets, requires the Server to be started in 'Debug'
mode.

» As before, you start the server from the Server Perspective. Select the server
Instance to start, right click, and select 'Debug'. This causes the server to be
started in Debug mode.

September, 2002 (c) IBM Corporation



Debugging ...

= Step through breakpoints
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» From the Navigator view, locate your Input HTML, right click and select 'Run on
Server'.

» The servlet will be started and executed up to the first breakpoint.

» At this point, you can select the Variable view and monitor variables, or the
Process view and monitor processes or remain in the Debug mode and step
through your breakpoints.
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Accessing Different DB2 Servers when
using DataSource

E Edit a bata Source =
= |[n Server Perspective Memes [TSowsAD
» Change server-cfg.xmil JNDI rame: * [idb e/ TSOWSAD
= Edit DataSource to Diescription: DBz 330 Linusx
match CCA Categorny: |
e Database alias EslrmE e [pTsOWSAD
e Userid Diefault user [0: {reggyr
e Password Default user password: |
Minimurm pool size: |
DB2 CCA patabase alias used to R el [1o
access different DB2 Servers
Connection timeout:  [180
ldle tirmeout: [1800
‘D DTSOWSAD  DTSOWSAD Orphan timeout: [1800

~Datahase Properties

Targetdatabase; [TSOWSAD  Protocal,  TCR/IP

System: DEMOLINK ~ Hostname: zsenverlx.demopkg.lm.com

Instance; [Unknown]  Portnurmber50004
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Statement cache size: I1 oo

I” Disahle autao connection cleanup
I Enahble JTA
* Reguired field.

(olLs I Cancel

~ When using DataSource, and the same schema exists on different DB2 servers,
changing your servlet only requires changing the server-cfg.xml file of your
Server Instance.

» To change to a different DB2 server, change the Database name to the DB2 alias
of the system you want to connect to, as defined in CCA. Additionally include
your userid/password for this DB2 server, since we didn't create panels to allow
entering this information in our examples.

» We change our Database name to DTSOWSAD which is our Linux on z/OS DB2
V7 system.
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» To test access to our Linux DB2 server, we launch the HTML as before.

Test Servlet ...

= From the Navigator view,

» Select the input HTML, Run on Server

m Enter '12' for QUANTITY
» Click Submit
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for a quantity and click Submit.
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Test Servlet ...

= Data now comes from DB2 V7 Linux on z/OS

» Server significance was included in the data
¥t Mocak oot BOE O teotE Dl ar'ddaby) e inrylputFaim iml

Result Table
Back Refresl Details
Select PARTNUMEER NAME QUANTITY COST
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- [To TeamLinm: 1 fon.o0
Tl PegeyLimm 1 11.00
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» The results set JSP table is returned with all parts that have a quantity of less
than 12 in stock.

» Since we included significance in our data by adding Linux in the name column,
we can see we have now accessed our Linux DB2 server
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Repository Support

= Team Development support
» Uses repository
= Concurrent Version System (CVS) or Clear Case Light are freeware
» Can compare different versions
— Replace with prior version if needed
» Conflicts are shown

= CVS URL
> WWW.CVS.0rg

m Clear Case Light URL
» www.rational.com

1] oata Management Sattware 5

» WSAD supports team development and provides repository support. No
repository comes with WSAD. Instead you install your repository of choice.
CVS and Clear Case Light are two optional freeware repositories.

» A repository allows you to compare different versions, replace with a prior
version during code development as well as identify any conflicts.

» The URLSs for CVS and Clear Case Light are listed.

» Development of this presentation installed and used CVS. Directions for setting
this up and using with WSAD can be found in the article:

» Team Development with WebSphere Studio Application Developer 4.0 --
Part 2: Installing and Configuring CVS as an SCM Repository
» www7b.boulder.ibm.com/wsdd/library/techarticles/0202_yu/yu2.html
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Summary

= One tool, WSAD includes comprehensive IDE for multiple job
functions and tasks

= Tailor by needs

= Many wizards for helping create access to DB2 Data

» Switching platforms can be done using DataSource or
DriverManager

m Best way to learn is to try examples and get first hand

experience

1] oata Management Sattware & = ms

» In Summary, WSAD provides a comprehensive development platform that
addresses multiple job functions and tasks in a single tool.

» You can tailor the different perspectives according to user preference.

» Many wizards are included to help create Java related components. Today's
presentation focused on describing some of the ways WSAD can be used to
create Java applications and servlets to access DB2 Data on multiple platforms
using both DataSource and DriverManager connection support.

» The best way to learn more about WSAD is get first hand experience using the
product and the Redbook, SG24-6407.
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» Other related presentations being given at this conference are listed here.

September, 2002

Additional Information

= Other related DB2 Technical Conference presentations

» BO5 An Introduction to XML for Database Specialists - Susan
Malaika
= Tuesday 10:15, Thursday 2:15

» B06 Web Services (SOAP) for DB2 - Susan Malaika
=Wednesday 2:15, Friday 10:15

» B0O7 Web Services and How DB2 Plays - George Zagelow
— Tuesday 8:30, Thursday 10:15

» BO8 XML and DB2 - George Zagelow
=Wednesday 10:15, Friday 8:30

» FO7 Developing DB2 Applications using Web Services and
Messaging - Connie Nelin
= Tuesday 8:30, Friday 8:30
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Additional Information ...

= Updates for this presentation found at
» www.ibm.com/software/data/db2/0s390/support.html
= Product Information -> Technical Presentations
= \WebSphere Developer Domain
» www?7b.software.ibm.com/wsdd
= |BM Redbooks (www.redbooks.ibm.com)
» SG24-6585: WebSphere Studio Application Developer Programming Guide
» SG24-6817: Websphere Application Server: Test Environment Guide
» SG24-6176:1BM WebSphere V4.0 Advanced Edition Handbook
» SG24-6219: Connecting WebSphere to DB2 UDB Server
» SG24-6176:I1BM WebSphere V4.0 Advanced Edition Handbook,
» SG24-6134: WebSphere Version 4 Application Development Handbook
» SG24-6292: Web Services Wizardry with WebSphere Studio Application Developer

» SG24-6407: Self-Study Guide: WebSphere Studio Application Developer and Web
Services <== used extensively in developing this presentation

MY THANKS to UELI WAHLI!
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» Additional information can be found on these websites and in the IBM Redbooks
listed here.

» My thanks again, to the wonderful work by Ueli Wahli and his ITSO residency
team indevelopint SG24-6407.
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Product Levels

m \WWSAD 4.02

m DB2
» Windows V7 at FP7
» Linux for z/OS V7 at FP5
»z/OS V7

1] oata Management Sattware T

» The product levels used when creating this presentation are listed here.
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» The DDL on this slide was used to create comparable Schema for DB2 on z/OS

V7.
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Appendix

= 390 DDL for Examples

CREATE DATABASE ITSOWSAD;
COMMIT;
CREATE TABLE ITSO.AAPARTS
(PARTNUMBER CHARACTER(10) NOT NULL,
NAME CHARACTER(30),
DESCRIPTION VARCHAR(100),
WEIGHT  DOUBLE,
IMAGE_URL VARCHAR(100) NOT NULL) IN DATABASE ITSOWSAD;
COMMIT;
ALTER TABLE ITSO.AAPARTS
ADD CONSTRAINT PARTKEY PRIMARY KEY (PARTNUMBER);
COMMIT;
CREATE TABLE ITSO.AAINVENTORY
(ITEMNUMBER INTEGER NOT NULL,
PARTNUMBER CHARACTER(10) NOT NULL,
QUANTITY  INTEGER NOT NULL,
COsT DECIMAL(10, 2) NOT NULL,
SHELF  CHARACTER(2),
LOCATION VARCHAR(100)) IN DATABASE ITSOWSAD;
COMMIT;
ALTER TABLE ITSO.AAINVENTORY
ADD CONSTRAINT ITEMKEY PRIMARY KEY (ITEMNUMBER);
COMMIT;
ALTER TABLE ITSO.AAINVENTORY
ADD CONSTRAINT ITEMPART FOREIGN KEY (PARTNUMBER)
REFERENCES ITSO.AAPARTS(PARTNUMBER)
ON DELETE NO ACTION
ON UPDATE NO ACTION;
COMMIT;
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CREATE TABLE ITSO.MMPARTS
(PARTNUMBER CHARACTER(10) NOT NULL,
NAME ~ CHARACTER(30),
DESCRIPTION VARCHAR(100),
WEIGHT ~ DOUBLE,
IMAGE_URL VARCHAR(100) NOT NULL) IN DATABASE ITSOWSAD;;
ALTER TABLE ITSO.MMPARTS
ADD CONSTRAINT PARTKEY PRIMARY KEY (PARTNUMBERY);
COMMIT;
CREATE TABLE ITSO.MMINVENTORY
(ITEMNUMBER INTEGER NOT NULL,
PARTNUMBER CHARACTER(10) NOT NULL,
QUANTITY  INTEGER NOT NULL,
COST  DECIMAL(10, 2) NOT NULL,
SHELF  CHARACTER(2),
LOCATION VARCHAR(100)) IN DATABASE ITSOWSAD;
COMMIT;
ALTER TABLE ITSO.MMINVENTORY
ADD CONSTRAINT ITEMKEY PRIMARY KEY (ITEMNUMBER);
COMMIT;
ALTER TABLE ITSO.MMINVENTORY
ADD CONSTRAINT ITEMPART FOREIGN KEY (PARTNUMBER)
REFERENCES ITSO.MMPARTS(PARTNUMBER)
ON DELETE NO ACTION
ON UPDATE NO ACTION;
COMMIT;
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